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CHAPTER 1

Preparation for  
Working with Old 
Historical Photos
This chapter will discuss how to prepare your photos for scanning as well 

as what kind of scanner may be best for your project and then how to 

proceed with the scanning and saving of the scan file.

Note this chapter does contain projects found in the Volume 1 
Chapter 1 folder. Note that in my previous books, such as Accurate 
Layer Selections Using Photoshop’s Selection Tools and Creating 
Infographics with Adobe Illustrator: Volume 1, the focus was on 
scanning sketches which did not necessarily require a high degree of 
quality in regard to color and resolution, and so a scanner that could 
scan slides was not required. In this chapter, we will be assuming 
that, besides photo prints, you will also be scanning slides and 
negatives, so some new topics not discussed in those books will be 
discussed here.
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�Brief Photo History and Reason 
for Photographic Damage
As mentioned in the introduction, most photos in recent years are taken 

with your digital camera, which may be a separate piece of hardware 

(physical digital camera) or an application that is part of your smartphone 

which has a built-in camera. What we understand as photography has 

been around since the 1700s – the process of trying to capture and retain 

images on light-sensitive materials; the use of dyes to preserve that image 

on a substrate whether a film or a paper. Over the centuries, the camera 

evolved from using glass plates and paper to film starting around 1888 and 

then on to digital in 1975. However, up until the early 2000s, when digital 

cameras improved and became more affordable, it was still common for 

people to use film cameras and to store their prints in an album, negatives 

in sleeves, or slides in a reel or box to keep them dust-free and away from 

the light. Refer to Figure 1-1.
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Figure 1-1.  Collection of storage options used to store print photos as 
well as film slides and negatives

While this book’s purpose is not to go into the history of photography, 

negatives, and slides, it’s still important to know a bit about why the items 

you are reviewing may appear damaged.

In the case of prints and film (negatives and slides), oftentimes the dye 

on the paper or in the film emulsion in combination with dye couplers 

does age and fade when exposed to the light or due to other environmental 

issues, such as temperature, moisture, and humidity. In the case of 

damage to slides this can often leave us with many instances, depending 

on the film brand, in which normal colors of red, green, and blue sensitive 

layers have begun to fade and become solidly red, green or blue, this 
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is often dependent on the dye that used in the manufacturing process. 

Over time, for example, when a slide becomes red, it means that the cyan 

dye has become unstable and chemically broke down, leaving only the 

red (magenta) and maybe yellow dyes. Note that for film, the dull side is 

considered the side with the emulsion. Refer to Figure 1-2.

Figure 1-2.  Aged film turning red, a purple-blue color, and normal 
colorizing

Likewise in other media like the paper displaying the printed image, 

these dyes can also break down and fade when exposed to the light. Also, 

if exposed to certain glues for mounting the image in place, the adhesive 

chemicals soak into the paper; they are acidic, this yellows the paper. You 

may recall seeing albums with the clear plastic that seals the photographs 

onto the glued white cardboard. Refer to Figure 1-3.
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Figure 1-3.  Pages from an album with the images mounted with glue 
and covered with plastic seals

This is one of the worst things you can do to a photo, so care must be 

taken to remove the image without ripping the photo. If you have any of 

these, transferring them for now into an album with just plastic sleeves 

and no glue or tape is a better option. The plastic sleeves should be ones 

that are for photo protection and do not contain PVC or PVA plastics. Also, 

researching archive storage boxes is another option.

The film of the slides and negatives can turn yellow over time and 

become brittle. Also, if the film is handled incorrectly and touched with 

ungloved fingers, the natural oils in our skin can erode the emulsion, and 

our fingernails can scratch it and the shiny film side as well. Having clean 

hands and a pair of white lint-free cotton or nitrile gloves is good for this 

kind of work. Avoid gloves that have been pre-dusted with chalk. On the 

shiny film side (not the dull emulsion side), if you do need to clean any 

fingerprints off, you can try a microfiber cloth or a cotton swab and a 
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small amount of 91–99% Isopropyl Alcohol and rub the spot very gently 

to remove the fingerprints. Do not use water which may soften the film 

gel. Practice on a piece of film first which you are not concerned about 

damaging. Your local photo lab or museum may have some suggestions as 

well. Refer to Figure 1-4.

Figure 1-4.  Carefully cleaning the shiny side of a black and white 
negative with gloves and a cotton swab dipped in Isopropyl Alcohol

Note that Isopropyl Alcohol is both poisonous and flammable. Read 

instructions on how to use small amounts correctly and also store and 

keep out of reach of animals and children.

Some prints, if stored correctly under the right conditions like in a 

museum or archival vault that is regularly monitored, can last hundreds 

of years. This is not the case in our own homes where our main focus is 

not continuously on historical preservation. This is why in your collection, 

there may be a few pristine images, but more than likely many will have a 

torn edge, rips, and creases.
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One final “damage” factor that I will mention before we look at 

scanning is the fact of whether the photo was taken professionally or not. 

Whether it is recent or not, there is still the possibility of dust being on the 

lens, parts of the image being out of focus, and over- or underexposed and 

unintended objects, animals, or people appearing in the shot. These too 

can be things that we may want to “correct” as well, and much of this can 

be done with Photoshop as you will see in the following chapters. These 

are all factors to consider when deciding what level of authenticity your 

historical images should retain.

�Organization of Your Photos
Before you begin scanning or if you don’t have a scanner yet and need to 

purchase one, take some time to organize your prints, slides, and negatives 

into piles on the table or in boxes. Note how some negatives and slides are 

larger than others, and this will be important, as I will explain why shortly.

Some tools that may be helpful during your organization will be a 

magnifying glass, gloves to avoid touching the film (as mentioned in the 

previous section), and a small light table, and if the slides you have been 

given had an original projector, that can be helpful as well and save some 

time. Refer to Figures 1-5 and 1-6.
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Figure 1-5.  Some of the tools that you may need to review your 
film slides and negatives while cleaning with Isopropyl Alcohol, 
magnifying glasses, cotton gloves, and a light table

Figure 1-6.  Review your slides with the original slide projector if 
possible
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At this point, culling through what you do not intend to scan is all part 

of the organization process.

The main piles that you want to create are

•	 Prints larger than 8.5x11: This could be, for example, 

large family portraits in black and white or sepia, but 

color prints as well.

•	 Prints smaller than 8.5x11: This could include very old 

sepia or black and white image that are mounted on a 

thick card stock. Some of these may be over a hundred 

years old. Others will be the more modern color prints. 

Refer to Figure 1-7.	

Figure 1-7.  Organize your prints into piles as you work on them
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•	 Negative film: You may want to separate color negatives 

and black and white into piles as well as thinner 

and wider sizes. Leave the film in its plastic sleeves 

as you sort. Examples of most common sizes would 

be 135 (24mmx36mm), 126 (28x28mm), and 110 

(13mmx17mm). However, do expect a few that do not 

fit these ratios, depending on the camera that was used, 

such as the larger 120/122 medium format film. Refer 

to Figure 1-8.	

Figure 1-8.  Organize your film negatives into piles of color and black 
and white of various sizes
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•	 Slides (positives): Like slides, negatives come in a 

variety of sizes too, but the most common is 50x50mm 

or 135; however, they can vary in thickness of the paper 

or plastic that surrounds them. It’s important to keep 

common thicknesses and sizes together, during your 

organization. Refer to Figure 1-9.	

Figure 1-9.  Organize your slides into various categories and observe 
the thickness of the paper and plastic slide holders

Chapter 1  Preparation for Working with Old Historical Photos 



12

Also, while working on the slides, note if any are falling out of their 

holder and set aside; do not run these through the projector as they may be 

damaged further. Instead, view them on a light table with your magnifying 

glass. These, however, should be OK to scan later on a flatbed scanner.

�Scanner Purchase
In this chapter, we will now begin with looking at the kind of scanner 

that you can use to start digitizing your photos as well as when to use 

Photoshop’s dialog box to do the scanning, when to rely on the scanner’s 

dialog box, and finally how to complete the scanned process in Photoshop, 

view the scanned image, and review it. As you will see, there are various 

options to digitize your prints and slides based on their physical format.

To begin, it is important to determine what kind of scanner you 

require. Most flatbed scanners can be acquired at an office supply store 

or online. For basic photo, artwork, and document scans, they are quite 

affordable, and many brands are compatible with Photoshop. Refer to 

Figure 1-10.
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Figure 1-10.  An illustration of a flatbed scanner connected to the 
tower of a computer and wall power supply

If you are only working with a photographic print or already have a 

scanner that does not scan film, you can begin your process of scanning 

these images with your flatbed scanner. In most cases, the size of the print 

will be under 8.5x11.7 inches, which is slightly larger than a letter size. 

However, for those that are over 8.5x11, if higher quality is important you 

may need to research online for a photo or archival service that can scan 

large format artwork. Or you could try using your digital camera and taking 

a picture of the image yourself while the digital camera is mounted on a 
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stable tripod to avoid camera shake. I’ll mention this option at the end 

of the chapter. Alternately, you can scan your large photo in sections or 

separate images, but this will require you to “stitch” the image together 

again in Photoshop. If you plan to do that, just make sure you have enough 

of an area to move your image around the scanner to accommodate the 

paper size so that nothing collides or bends the paper, causing further 

damage. Refer to Figure 1-11.

Figure 1-11.  An illustration of a photo print that is too large for the 
scanner: it needs to be moved to scan twice, but there is a coffee cup in 
the way that should not be there, as they may collide

However, if the flatbed scanner that you have does not specifically 

mention that it can scan negatives and slides, you will have to consider 

purchasing one or looking into other services that can do that. Though not 

a topic of this book, it should be noted that some of these services, which 

would be available through your local photo lab, print house, library, 

Chapter 1  Preparation for Working with Old Historical Photos 



15

or museum, may even be able to offer services to digitize movie films 

and audio tapes or reels. However, while I will not discourage you from 

researching these services, if you want to give your slides and negatives the 

attention they deserve, I recommend looking at two scanner options.

�Types of Scanners for Film Slides and Negatives
For a scanner to scan any kind of transparent film and prints, it needs to 

have two light sources, one from above (backlight transmissive) for film 

and one from below for prints (reflective). A scanner that only scans prints 

has one light source from below which is reflective. Refer to Figure 1-12.

Figure 1-12.  An illustration of a scanner with two light sources 
showing the location of the lights

While it is not impossible to add a backlight source above your flatbed 

surface, I have done this using the following:

•	 A handheld LED white/RGB light wand set to white 

lighting.

•	 Covered the light and the film with aluminum foil to 

increase the light.

•	 Placed a thin white tissue paper in between the film 

and light wand to diffuse any light glare. Refer to 

Figure 1-13.	
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Figure 1-13.  An illustration of how I worked with my scanner when 
it would not allow me to scan the film

I had to do this when the light above my older film flatbed scanner 

stopped working due to a software upgrade and I had a deadline. While 

this work-around may be OK for a few slides or negatives, this is not an 

ideal solution as you will want to be scanning for a print quality. What 

is considered a good resolution (300–600dpi [dots per inch]) for paper 

scans is not ideal for tiny negatives and slides as they need a much higher 

resolution such as 1200–12,800dpi to be blown up accurately later for a 

print. I’ll discuss more about resolution options shortly. Also, in most 

cases, when scanning film only, the backlight is active while it moves with 

the scanner head, and the front light is inactive.

Here are two scanner solutions that I would suggest.

Portable stand-alone digital film scanner with a large LCD screen: 

This is a good option if you already have a flatbed scanner or need to 

work in various locations in your house or a house not near your personal 

computer. You only need to plug the scanner into your wall, and it does 

not need to be connected to your computer while you work. The images 

are transferred onto your SanDisk Ultra PLUS SDHCTM UHS-I Card which 

is 32GB (gigabytes); this is the same kind of card that you would use in a 

digital camera. The film images are loaded and viewed one at a time, and 

the scans are completed with a click of a button, which is quite fast. You 

can then take out the card and insert it into your laptop or home computer 
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and copy them off the card to work in Photoshop. Refer to Figure 1-14. I 

like that these types of scanners can scan 50x50mm slides and can handle 

several slide thicknesses, color negatives, as well as black and white 

negatives in various common sizes:

•	 135: 24mmx36mm

•	 126: 28mmx28mm

•	 110: 13mmx17mm

Figure 1-14.  An illustration of a portable stand-alone digital film 
scanner, plugged into the wall with a holder and an SDHC card

Note some portable scanners will also come with the option to scan 
120/122 medium format film. In my case, I was experimenting with 
the Hammacher Schlemmer model, which does not have the option of 
medium format film. For each type of slide or film, there are separate 
holders, and the highest resolution is around 3200dpi.

This kind of scanner comes with built-in software that can correct for 

dust and scratches as well as basic brightness and color adjustments, which 

you can always choose to do later in Photoshop yourself. However, there are 

a few drawbacks with this option. If your slides or negatives are oversized 

and not the common sizes, parts of the images will be chopped off during the 

scan. You may be able to compensate slightly by turning the film around to 
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do a second scan or try to insert the film without the adaptor/holder in place, 

but you would later have to stich the two images together in Photoshop; the 

point of the adaptor is to keep the film level straight, which is not easy to do 

without the adaptor. Also, while the stand-alone scanner is fast, if you want 

to scan several slides or negatives in one scan this is not possible.

Flatbed photo scanner with the option of slides and negatives: This 

is best if you do not have a scanner yet or need to upgrade your current 

flatbed scanner. With this type of scanner, it will have a direct connection 

to the computer so that you can work on your photos right away in 

Photoshop, which I will talk about in more detail shortly. This type of 

scanner is ideal if you need to scan your reflective prints up to 8.5x11 with 

a single light. The back or inner lid of the scanner is covered with a white 

document mat. Refer to Figure 1-15.

Figure 1-15.  A flatbed scanner with and without the mat cover and 
one of its holders for scanning film
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For film slides and negatives, these scanners have two lights; the 

document mat is removed to reveal the second light, and now the above 

backlight (transmissive), which is meant to illuminate the slide, is visible, 

while in this case the lower light that was used to scan the print is off, but 

the lower scanner cartridge inside the document table still moves with the 

backlight to capture the scan. Like the portable scanner for film, it can scan 

a variety of common sizes mentioned earlier. However, you can not only 

scan several in one scan, you can also easily move the larger film negatives 

or slides around to get a more accurate scan. As mentioned, for scans of 

prints larger than 8.5x11, you may need to consider contacting a photo 

lab or local library to see what options they would recommend. Flatbed 

scanners often come with additional adjustment options before entering 

Photoshop, which I will discuss later. For my testing, I was using the Epson 

Perfection V600 Photo model.

As with any electronic purchase, make sure you do some online 

research of the product first and check out the reviews of the product 

before you buy.

�Scanner Basics Review (Maintenance)
Whether you are scanning slides or prints, it is important to keep your 

scanner, holder, and film clean and dust-free. If you have a portable 

stand-alone digital film scanner, make sure to read the user manual 

and use the recommended cleaning tools regularly before and after you 

finish scanning your projects so that dust and dirt do not build up on the 

glass, and keep your device away from extreme temperatures and high 

humidity. The same is true of the flatbed scanner, clean it regularly with 

the recommended cleaning cloth to remove fingerprints and smudges. 

Refer to Figure 1-16.
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Figure 1-16.  An illustration of a person cleaning the flatbed scanner 
glass and removing smudges and dust before use

Note you can use an eyeglass lens cloth to clean the surface of the 
glass and, if required, a mild glass cleaner if recommended by the 
manufacturer. Be careful not to scratch the glass as this can happen 
if you press down on the scanner lid and scan a booklet’s coil that 
has any rough metal edges. Also, you should not have your scanner in 
an area of high humidity as the glass surface inside the scanner can 
fog up, leaving streaks which are difficult to clean.

For the flatbed scanner, make sure that your software drivers remain 

up to date so that the hardware can connect to the computer. Also, as with 

any printer, monitor, or scanner over five to ten years, the light gradually 

fades and loses its ability to calibrate colors accurately. The older scanner 
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hardware may be operational, but very likely is not the best for color 

photo scans where color is crucial for print or the Web. So you will want to 

monitor this over time and upgrade your hardware as required. Note this 

is not the same as the color correction you will be doing on your prints in 

Photoshop. However, it’s important, if required, once you have finished a 

corrected photo, to print out a copy and compare with how it appears on 

the screen. We’ll discuss that more in Volume 2.

As noted, if you have been using a portable stand-alone digital film 

scanner, consult the user manual to determine how to scan each slide or 

negative. If using the holders, make sure to place your film negative or 

slide in the correct orientation, keeping the dull emulsion surface facing 

towards the light source. Then, using a combination of the LCD screen to 

preview, built-in software, and scan buttons, each scan will be added onto 

the SDHC card, and then you can later remove it and insert it into your 

computer slot and preview on your computer. Note that if your computer 

does not have this slot, you can purchase a USB card reader adapter, 

which can accept a variety of card sizes. The file format will be an RGB 

color mode (.jpg), which you can open in Photoshop and get ready to start 

working on in Chapter 2.

However, for now let’s discuss the assumption that you are working 

with your flatbed scanner and personal computer. Refer to Figure 1-17.
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Figure 1-17.  An illustration of a flatbed scanner connected to a 
personal computer

Make sure to take time to install the software and consult the online 

user manual if any of your settings are slightly different than mine. Once 

your scanner is set up and turned on, you can directly connect to it via 

Photoshop using the Wizard Assists (WIA). For photo prints, this is a quick 

way to scan. I have delved into this in more detail for scanning sketches in 

the past, in the books I mentioned in this chapter. However, in this book, I 

will just delve into it very briefly, because using this method does not work 

well for slides and negatives, and you must use the scanner’s own dialog 

box to accomplish this.
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�Flatbed Scanner Option 1: Quick Scans of Photo 
Prints Directly into Photoshop
A flatbed scanner allows you to acquire the scan of a flat sheet of paper 

without the presence of outside light which could cause color distortions 

to your images. Some flatbed scanners will allow you to adjust the top 

lid so that it sits better on a large scan that has a higher raised surface. 

Other scanners have just a hinged lid so the bed might be exposed to 

outside light.

Ultimately, if you’re dealing with a photo that is either raised on a 

card or in an album that has binding that does not bend well, I would 

recommend placing a dark cloth sheet over your scanner to prevent any 

outside light from coming into the scanner as well. Refer to Figure 1-18.

Figure 1-18.  An illustration of a flatbed scanner covered with a black 
cloth to prevent shadows and gutter shadow on an album, near the spine
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You may get a gutter or side shadow between the pages during the 

scan; if at all possible, try to get the scan as flat as possible by taking it out 

of the photo cover or album. Refer to Figure 1-19.

Figure 1-19.  An illustration of a flatbed scanner covered with a single 
image laid on the scanner bed face down for scanning

Or if the prints cannot be removed from the album without damaging 

them further, you may have to use the lid of the scanner and with your 

hand gently press down to press the image a bit flatter.

Some scanners have software that can correct this gradient 

discoloration. However, you can use Photoshop and its adjustment 

layers afterward to clean this up and other issues, using a combination 

of selections and masks, as we will see in subsequent chapters 

and later in Volume 2.

In most cases, you will place your print face down on the glass in the 

upper right-hand corner next to the arrows or guides. If you are scanning 

multiple smaller images, place them as close together as possible using the 

right edge of your scanner as the guide, but try to avoid overlap.
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Take a moment to review your scanner’s manual or online specs as 

every one is built slightly differently, depending on the manufacturer. 

Your scanner should be able to scan at least 300–600dpi (dots per inch) or 

higher up to 2400dpi for a good quality.

In Photoshop, to connect to your scanner, you would make sure your 

scanner is plugged in and that it is turned on and connected to a USB port 

and that your computer is recognizing the device and the drivers are up to 

date. Most scanners have their own quick menu as well that you can access 

if you’re not able to connect to Photoshop at first, but we will look at that 

more closely in the next section.

Adobe gives some helpful information on this topic of connecting 

to Photoshop. Depending on whether you are using a MAC or Windows 

computer, go to

https://helpx.adobe.com/photoshop/using/acquiring-images-

cameras-scanners.html

Refer to Figure 1-20.

Figure 1-20.  Photoshop icon

However, let me demonstrate how the typical procedure of image 

acquisition might go, though there may be slight differences depending 

on your computer or scanner version. I demonstrate the steps I use for 

my scanner in Photoshop CC 2024 on the Windows 10 computer. Refer to 

Figure 1-21.

�Scanning the Photo

	 1.	 Once you open Photoshop, go to File ➤ Import ➤ 

WIA Support. Refer to Figure 1-21.
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Figure 1-21.  WIA Support dialog box

You will be presented with a dialog box where 

you will use the Wizard Assists or Windows Image 

Acquisition (WIA) to help you decide where you 

will place your scans. You can also use this area for 

compatible digital cameras should you be using a 

USB cable to connect. You would then browse for a 

Destination folder where the images will be stored 

and then choose to enable or disable options such as

	 a.	 Should the acquired images appear and open in Photoshop 

and when acquired by the scanner.

	 b.	 Should each image be stored in a unique, created subfolder 

using today’s date so that you can review them later. Refer to 

Figure 1-22.

Figure 1-22.  Subfolders containing individual scans
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	 2.	 When you have made your selections, click the Start 

button to move to the next dialog box or click the 

Cancel button to exit and not save your changes.

	 3.	 When you click the Start button, you will then 

be presented with the Select Device dialog box; 

in this case, it lists the scanner which is selected 

and its properties which will vary depending on 

the manufacturer and driver setup as per setup 

instructions. As mentioned earlier for the scanner, 

always make sure your drivers and software are 

up to date, so the scanner will be recognized and 

appear here. Refer to Figure 1-23.

Figure 1-23.  Select Device dialog box where you can choose a digital 
camera or scanner that you want to acquire images from
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	 4.	 While it is selected, click OK. This should then 

take you to the scanner dialog box, and you will 

be presented with various options on how to scan. 

Refer to Figure 1-24.

Figure 1-24.  Scan using WIA (scanner name) dialog box with its 
various options

In my case for this scanner, I can scan a

•	 Color picture

•	 Grayscale picture

•	 Black and white picture or text
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In most cases, when scanning a document, the 

default quick selections of color picture or grayscale 

are adequate, but I will choose those via the Custom 

Settings radio button and then click the lower 

link that says Adjust the quality of the scanned 

picture. This is best practice when working with 

print photos.

	 5.	 This brings up the Advanced properties dialog box, 

which gives me more options so that I can adjust 

the resolution to 300dpi (dots per inch) up to 600dpi 

or higher for other scanners. As well, I can adjust 

the brightness and contrast of the image. This can 

be reset as well. I generally leave those settings at 

zero and do that type of appearance correction in 

Photoshop, but depending on your scanner after 

some experimentation, you may want to move these 

sliders or whatever other settings are available for 

you. Refer to Figure 1-25.
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Figure 1-25.  Advanced Properties dialog box and various options

Later in Option 2, I will look at how you can get 

additional setting from your scanner’s dialog box.

	 6.	 I will then choose the Picture type from the drop- 

down menu, which is the same as the earlier 

choices, and click OK to confirm.

	 7.	 I would then place the image I want to scan on the 

scanner bed face down – in this example, in the 

upper right hand near the edge – close the lid, and 

in the Scanner WIA dialog box, click the Preview 

button. Refer to Figure 1-26.
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Figure 1-26.  Print is placed on the scanner face down, and then 
the Preview button in the dialog box is clicked to get a preview of 
the photo

In this case, the preview does not create a copy of the image yet; it 

is just stored in memory until you are ready to click Scan. If you notice 

that your image is a bit slanted or rotated, you can always open the lid, 

move the print a bit from the center to the left or right so it’s up against 

an edge, close the lid, and click the Preview button again. Some scanners 

will recognize the area of how large your artwork is and then will use their 

bounding box handles to crop or marquee to fit around that area, so you 

don’t have to scan the whole bed. You should have the option of being able 

to drag the handles to the area you want to scan. However, some scanners, 

via their dialog boxes, will allow you to scan more than one area on the 

page into separate files, if required, by letting you draw more than one 

bounding box and then scan all at the same time. Refer to Figure 1-27.
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Figure 1-27.  Preview of the print appears, and I can use the 
bounding box to crop how much of the sketch I want to scan

�Scanner Color Modes

Now, depending on the setting you choose, different file color modes 

will be generated via the basic or Advanced properties. For my 

scanner here are some examples:

A color picture will produce a .bmp 8-bit bitmap file in RGB color 

mode. The file is generally larger than a camera .jpg file, but it is as good 

as a .tif file, and it will not lose quality as a .jpg would and can be stored for 

archival purposes. Refer to Figure 1-28.
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Figure 1-28.  Scanner results top to bottom for a color picture 
on white paper, grayscale, and black and white picture or text 
(bottom image)

A grayscale picture produces a .bmp file; however, in this case, the 

color mode is Index and 8 bits. You can always convert it afterward in 

Photoshop, choosing from the menu Image ➤ Mode ➤ RGB color.

The black and white picture or text produces a .bmp file, but this time 

the color mode is Bitmap. I find this option to be the worst setting as the 

image is very grainy and broken. In most cases, even if the image is in 

Chapter 1  Preparation for Working with Old Historical Photos 



34

black and white, I will generally choose the Advanced properties of color 

picture as this produces artwork with the same or better detail than a 

digital camera.

	 1.	 Once you have made your setting choices, click 

the Scan button (see Figure 1-27), and the file will 

be transferred and appear in Photoshop and be 

saved in the destination subfolder that you set up 

earlier. You can check that it is 300dpi under the 

Image ➤ Image Size dialog box, and it will show the 

resolution to be 300 (pixels/inch), which is the same 

as the dpi setting. Click Cancel to exit that dialog box 

as you are not making any size adjustments. Refer to 

Figure 1-29.

Figure 1-29.  Checking the resolution of the document using the 
Image Size dialog box showing 300 Pixels/Inch resolution

Chapter 1  Preparation for Working with Old Historical Photos 



35

Note that for some scanners, though you scanned at 300dpi using 
this method, they may come in expanded with a resolution of 72dpi. 
Instead, in that case, you can use your Image Size dialog box to 
correct this, but we will review this in Chapter 2. Refer to Figure 1-30.

Figure 1-30.  Checking the resolution of the document using the 
Image Size dialog showing 72 Pixels/Inch resolution but a larger 
width and height

�Flatbed Scanner Option 2: Using Your Scanner 
Dialog Box for Prints, Slides, and Negatives
As noted earlier, while this is a fast way to scan your photos so that they 

directly appear in Photoshop, this is not the best way to scan your slides 

and negatives using the flatbed scanner as film settings are not recognized 

in the Photoshop dialog box.
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In this next example, I will just point out that for prints you can leave 

the document mat cover of the scanner on and scan using the scanner’s 

dialog box. However, when you need to scan your slides and negatives, you 

will need to remove the scanner document mat cover to expose the light 

in the transparency unit window so that the scanner will recognize you are 

scanning film. Refer to the illustration in Figure 1-15 and to your scanner’s 

user guide on how to do this correctly.

In this example, you would then select the holder that is right for your 

set of slides and negatives and then proceed to the scanner’s dialog box. 

Make sure that you review which side of the film should face the scanner 

glass (generally shiny side down or words if present are reversed). The 

scanner I am using has more features in the dialog box, and while I will 

not go into detail about all of them as your scanner may be different than 

mine, I will just point out a few that you should consider. In this case, the 

scanner has multiple user modes, and I am using the professional mode 

as it is most similar to the layout mentioned earlier in Option 1 when 

importing into Photoshop. Refer to Figure 1-31.
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Figure 1-31.  Various settings may be available through your flatbed 
scanner that are not available through Photoshop as seen for the 
Epson Scan in professional mode
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In this case, I use the current default settings, and I select what kind 

of original document type I am working with. If I had not removed the 

document mat cover, I would continue using reflective mode for my print 

and then adjust my next settings in the dialog box, such as document 

source “Document Table,” which is the glass surface, and Auto Exposure 

type, in this case, a photo and not a document. Refer to Figure 1-32.

Figure 1-32.  Choosing to scan a photo (reflective) print using the 
scanner’s dialog box

When scanning film, after you have removed the document mat, you 

would then switch your document type to Film and then choose a film 

type (Positive Film, Color Negative Film, or B&W Negative Film) and then 

select the correct holder as described in the user manual and lay it on the 

scanner glass and insert the film or slides as directed. For example scan 

with the dull emulsion towards the upper light source which will appear as 

a reversed image to you, this can insure the correct orientation of image or 

text in the preview and later for the scanned image. Refer to Figure 1-33.
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Figure 1-33.  Choosing to scan film slides using the scanner’s dialog 
box and placing the film slides in the holder for scanning on the right; 
the left side of the holder would be for negative film strips

Next, whether you are scanning prints or film, you would select from 

the options presented in the image type or color mode: some options 

in this example are 48-bit color, 24-bit color, color smoothing, 16-bit 

grayscale, 8-bit grayscale, and black and white. In most cases, I would 

suggest experimenting with the color settings even if the print is black and 

white. In this case, by default, it is set to 24-bit color which produces an 

8-bit RGB file (each color channel has 8 bits (8x3)). However, some slides 

may benefit from the 48-bit color setting, but it will still appear as an 8-bit 

RGB file when opened in Photoshop. I left the speed priority scanning 

unchecked. Refer to Figure 1-34.
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Figure 1-34.  Choosing a color mode from the scanner dialog box for 
a color print

Note that the image smoothing for my scanner will produce a type of 
posterized effect, and I would not recommend this setting or black 
and white for archival photos. Refer to Figure 1-35.

Figure 1-35.  Choosing a color mode of color smoothing for this 
print from the scanner dialog box is not the best choice; in this case, it 
would be better to use 24-bit color
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Next, set the resolution as this will affect the size of the file. For prints, 

setting it at 300–600dpi is generally best, but you may want to make it a 

higher number if you plan to make a larger print, though be aware that the 

graininess of the photo will likely determine how much you can enlarge 

the image without losing quality. Refer to Figure 1-36.

Figure 1-36.  Choosing the correct resolution for your prints or film

For film and negatives, experiment and use a much higher setting 

between 1200 and 12,800dpi. Note that if you are using a portable scanner 

that can scan at either 2400dpi or 3200dpi, this may be a good number to 

set on the flatbed as well if you want to compare scanning between the two 

products.

Then you will want to compare your document size and set a target 

size as required, based on either manually setting it in mm, inches, or 

pixels or a set ratio scale. Trimming may be on or off depending on other 

settings. Notice that if you wanted to have the image to be twice the 

size of the original at 200%, the target size will now be different than the 

document size. Refer to Figure 1-37.
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Figure 1-37.  Changing your scale from the original to the new 
target size

In the case of film, once the resolution is set and you have clicked the 

Preview, as you will see shortly, you may need to adjust the target size to 

one of the presets, so the file size is not too large. In this case, you would 

adjust the resolution down to match the higher scaling size that you want. 

Refer to Figure 1-38.
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Figure 1-38.  Altering your target size through scale and trimming 
and resolution for film after you have run a preview and compare 
possible file size

You will also notice that the scanner has some additional adjustment 

correction software that comes with it. I will leave these on the default 

setting as I make most adjustments in Photoshop. Depending on the 

scanner, using dialog boxes that appear when you click the various 

buttons, you could correct such things as autoexposure, histogram 

adjustment, tone correction, image adjustment, and color palette. These 

have slightly different names in Photoshop, and we will look at that more 

in Volume 2. Refer to Figure 1-39.
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Figure 1-39.  Various adjustment settings that may be offered in the 
scanner’s dialog box

Additionally, you also have some filter-like adjustments that affect 

blurriness, grain, color, backlight, and dust removal; you will learn about 

similar filters in Volume 2. Reading Volume 2 will give you a better idea of 

how to use them with a scanner, and you can then compare whether to use 

your scanner settings or the ones in Photoshop. For now, I will leave them 

at the default with Unsharp Mask on set to a level of Medium, but consult 

your scanner’s help menu if you need more details on these settings. Refer 

to Figure 1-40.

Figure 1-40.  Additional filter-like adjustment settings that may be 
offered in the scanner’s dialog box
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Note that in the case of color and black and white film negatives, your 

scanner may have the software to automatically invert them into positives. 

If not, I will show you in Volume 2 how you could do this.

Before you click the Preview or Scan button as you did in Option 1,  

locate the File Save Settings so that you know in what folder you are 

scanning the digital images to and, if required, adjust to a new location 

other than the Pictures folder. Refer to Figure 1-41.

Figure 1-41.  Checking the File Save Settings destination from the 
scanner’s dialog box

This scanner also allows me to adjust the file format choice. For now, 

I will leave it on the default of JPEG, though in other situations you may 

want to use a TIFF (.tif ) or BITMAP (.bmp) file as you saw in Option 1 if 

you are concerned about file compression. For a document, you can scan 

to a PDF, but make sure to consult the dialog box’s help menu if you need 

more information on what setting to use.

Other settings may be present as well for what to do for the next scan 

and whether the folder that contains the image should open automatically.

Click OK if you make changes or Cancel without making changes to 

exit. Refer to Figure 1-42.
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Figure 1-42.  Scanner’s File Save Settings dialog box and some 
possible image format options
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To begin the scan now, click the Preview button. This dialog box will 

have more options to zoom in and allow for single or multiple cropped 

scans when you marquee areas as well as rotation of the preview. Once 

you have the settings you need for the scanner, leave the preview open and 

click the Scan button, and again the File Save Settings dialog box may open 

just to confirm where you want to scan to. After clicking OK to confirm the 

File Save Settings, the images will transfer to the location you assigned. In 

this example, the files will not open automatically in Photoshop but will 

appear in the chosen Location folder. Refer to Figures 1-43 and 1-44 for 

some examples with prints and slides in the Preview dialog box.

Figure 1-43.  Previewing a print in the scanner’s Preview dialog box 
before scanning
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Figure 1-44.  Previewing a single slide in the scanner’s Preview dialog 
box before scanning, then clicking the Scan button to create the image
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Note that in the case of some larger film (medium format), such as 
older black and white negatives, you may need to use the Normal 
tab setting rather than an automatic Thumbnail to acquire the correct 
preview of the scan. The Normal tab in this example, as shown in 
Figure 1-43, would allow me to marquee the custom area I want to 
scan, while Thumbnail might break the single negative into two or 
more parts, which is what I don’t want. In Normal mode, I would also 
be able to scan several marquee photos at the same time.

So, as we can see, acquiring an image of your sketch via a flatbed 

scanner is very easy. You would then repeat these steps if you had any 

additional images to scan, and you could leave the Preview open as 

you work, as mentioned earlier, with the slides so that the file size and 

resolution are what you desire.

Remember, when you are finished with your scans, close each dialog 

box, clean the scanner, always put the document mat on again, and turn 

off your scanner.

You can then review your image in Photoshop by choosing File>Open 

and locating the file in your folder. Look at the color options of RGB and 

review the file formats you choose, in this case, a JPEG (.jpg), TIFF (.tif ), or 

BITMAP (.bmp). This will help you get a better understanding of how your 

scanner works, and you can learn to make better use of the software. Refer 

to Figure 1-45.

Figure 1-45.  Labels of scanned files in two formats and various color 
modes opened in Photoshop
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At this point, if you did make any Photoshop adjustments, which we 

will start to look at in Chapter 2, you may want to save (File ➤ Save [Ctrl+S 

or CMD+S]) your files that you scanned to your desktop, a USB flash drive 

stick, or external drive as a backup. Otherwise, close your scans for now 

(File ➤ Close).

�A Digital Camera (for Large Format Files)
As mentioned before, for larger prints such as family photos or scenery 

that cannot fit in your scanner that you may want to incorporate into your 

project, you can use a digital camera. You may have to experiment with a 

few shots until you get the best quality. Refer to Figure 1-46.
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Figure 1-46.  Capture your artwork with a digital camera

For example, if the camera needs to be close or the surface is shiny, do 

not use a flash as it will cause a reflection and the image will disappear. Use 

a tripod to avoid shaky images even if your camera has auto stabilizer. Set 

up the image in a vertical or horizontal position. Also, check if your tripod 

has an option where the camera can point straight down on the table 

without tipping over when taking the picture. Refer to Figure 1-47.
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Figure 1-47.  Photo example of how you could use a tripod and a 
digital camera like a scanner for larger sketches
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Your camera should be at least 12 megapixels or higher. You can 

also experiment on a macro setting as this may produce a better-quality 

resolution. The image will likely be .jpg (JPEG) in RGB color mode and 8 

bits. To then acquire the image, you can then use the method that Adobe 

describes using a USB port drive connected to the camera:

https://helpx.adobe.com/photoshop/using/acquiring-images-

cameras-scanners.html

Or just take out the camera’s memory card, insert it into your 

computer’s drive, and copy the images that you want into a folder on your 

computer, as was mentioned with the portable flatbed scanner.

Either way, I have presented you with a variety of options for acquiring 

a digital image of your photos, and the choice is up to you.

If you need to refer to an example of a final scanned image in 

Photoshop, use File ➤ Open. If you want to practice, use the car_image.
jpg that I scanned from a slide.

You can at this point close any files you have open in Photoshop and 

then exit (File>Exit) the application as well.

�Summary
In this chapter, we discussed how to scan some of your photos, whether 

they be prints, film negatives, or slides. We looked at various scanning 

options, and we also looked at how to review the digital scans afterward 

in Photoshop. In the next chapter, you will review our tools and panels 

that you will find in the Photoshop workspace and begin your work on the 

digitized photo.
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